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artus® EBV TM PCR Kit

For use with the ABI PRISM® 7000, 7700 and 7900HT Sequence Detection

Systems.
For research use only. Not for use in diagnostic procedures.

Attention: The artus EBV TM PCR Kit may neither be used in combination
with the GeneAmp® 5700 SDS nor with the 384 plate format of the
ABI PRISMP 7900HT SDS.

1. Contents

Labelling Art. No. 4501103 Art. No. 4501105
and contents 24 reactions 96 reactions
EBV RG/TM Master 2 x12rxns 8 x 12 rxns
EBV LC/RG/TM QS 17
5x 10" cop/ul 1 x 200 pl 1 x 200 pl
EBV LC/RG/TM QS 2°
5 x 10° cop/jl 1 x 200 pl 1 x 200 pl
EBV LC/RG/TM QS 3°
5X10200P/u/ 1 x 200 pl 1 x 200 pl
EBV LC/RG/TM QS 4°
5x 10" cop/ul 1 x 200 pl 1 x200 pl
EBV RG/TM IC” 1 x 1,000 pl 2 x 1,000 pl
White Water (PCR grade) 1 x 1,000 pl 1 x 1,000 pl
* QS = CQuantitation Standard
IC = |Internal Control
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2. Storage

The components of the artus EBV TM PCR Kit should be stored at -20°C and
are stable until the expiry date stated on the label. Repeated thawing and
freezing (> 2 x) should be avoided, as this may reduce the sensitivity. If the
reagents are to be used only intermittently, they should be frozen in aliquots.

Storage at +4°C should not exceed a period of five hours.

3. Additionally Required Materials and Devices

* Disposable powder-free gloves

* DNA isolation kit (see 8.1 DNA lIsolation)

* Pipettes (adjustable)

» Sterile pipette tips with filters

* Vortex mixer

* Desktop centrifuge with rotor for 2 ml reaction tubes

* Centrifuge with rotor for microtitre plates (optional)

* 96-well reaction plate/reaction tubes for optical measurement with
corresponding optical closing materials (see 8.4 Preparing the PCR)

* 96-well two-part retaining rack for use with optical reaction tubes
(96-Well Tray/Retainer Set, Cat. No. 403 081, Applied Biosystems),
see 8.4 Preparing the PCR

* Compression pad for use with optical adhesive covers (Optical Cover
Compression Pads, Cat. No. 4 312 639, Applied Biosystems), see
8.4 Preparing the PCR

* Applicator for sealing of the reaction plates using optical adhesive
covers (Adhesive Seal Applicator Kit, Cat. No. 4 333 183, Applied
Biosystems)

ABI PRISMP 7000, 7700 or 7900HT SDS

" The use of reaction tubes for optical analyses with domed caps is only permitted with
the ABI PRISM® 7700 SDS and requires an adjustment of the exposure time (see
8.5.2 Programming the ABI PRISMP 7700 SDS, 8.5.2.5 Important Additional Settings).
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Attention: A valid calibration of the pure dyes (Pure Spectra Component File)
and the background (Background Component File) is necessary when putting

the instruments into operation.

4. General Precautions

The user should always pay attention to the following:

* Use sterile pipette tips with filters.

e Store and extract positive material (specimens, controls and
amplicons) separately from all other reagents and add it to the
reaction mix in a spatially separated facility.

* Thaw all components thoroughly at room temperature before starting
an assay.

*  When thawed, mix the components and centrifuge briefly.

*  Work quickly on ice or in a cooling block.

5. Pathogen Information

Transmission of the Epstein-Barr virus (EBV) occurs orally, mainly via
contaminated saliva. In general, infection by EBV, especially if contracted in
childhood, is asymptomatic. The clinical sign of an acute infection is infectious
mononucleosis associated, with fever, tiredness and angina, as well as
inflammation of the lymph nodes and spleen. In some patients these
symptoms reappear chronically. Severe forms of EBV infection can be seen in

immunodeficient patients and people with T-cell defects.

6. Principle of Real-Time PCR

Pathogen detection by the polymerase chain reaction (PCR) is based on the
amplification of specific regions of the pathogen genome. In real-time PCR the
amplified product is detected via fluorescent dyes. These are usually linked to
oligonucleotide probes which bind specifically to the amplified product.

Monitoring the fluorescence intensities during the PCR run (i.e. in real-time)
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allows the detection and quantitation of the accumulating product without
having to re-open the reaction tubes after the PCR run (Mackay, 2004).

7. Product Description

The artus EBV TM PCR Kit constitutes a ready-to-use system for the
detection of EBV DNA wusing polymerase chain reaction (PCR) in the
ABI PRISM® 7000, 7700 and 7900HT Sequence Detection System. The
EBV RG/TM Master contains reagents and enzymes for the specific
amplification of a 97 bp region of the EBV genome. The amplicon is detected
by measuring the FAM fluorescence in the ABI/ PRISM® SDS. In addition, the
artus EBV TM PCR Kit contains a second heterologous amplification system
to identify possible PCR inhibition. This is detected as an Internal Control (IC)
by measuring the VIC fluorescence. The detection limit of the analytical
EBV PCR (see 11.1 Analytical Sensitivity) is not reduced. External positive
controls (EBV LC/RG/TM QS 1 - 4) are supplied which allow the determination
of the pathogen load. For further information, please refer to section
8.3 Quantitation.
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8. Protocol

8.1 DNA Isolation

Various manufacturers offer DNA isolation kits. Sample amounts for the
DNA isolation procedure depend on the protocol used. Please carry out the
DNA isolation according to the manufacturer's instructions. The following

isolation kits are recommended:

. QLare (%E)A 51 304 QIAGEN | not included
Plasma, €57 Gllamp }lgi't”éﬁfns 53 704 QIAGEN included

Blood cells | A2mP E{;‘gg""’d 51104 QIAGEN | not included
Plasma VirE?Kli??fS)* 62 724 QIAGEN included

*To be wused in combination with the BioRobot EZ1 DSP Workstation
(Cat. No. 9001360) and the EZ1 DSP Virus Card (Cat. No. 9017707).

Important note for the use of the QlAamp UltraSens Virus Kit, the
QlAamp DNA Blood Mini Kit, and the QlAamp DNA Mini Kit:

* The use of carrier RNA is critical for the extraction efficiency and,
consequently, for DNA/RNA yield. If the selected isolation kit does not
contain carrier RNA, please note that the addition of carrier (RNA-
Homopolymer Poly(A), Amersham Biosciences, Cat. No. 27-4110-01) is
strongly recommended for the extraction of nucleic acids from cell free
body fluids and material low in DNA/RNA content (e.g. CSF). Please
proceed as follows in these cases:

a) Resuspend the lyophilised carrier RNA using the elution buffer (do not
use lysis buffer) of the extraction kit (e.g. AE buffer of the QlAamp
DNA Mini Kit/QlAamp DNA Blood Mini Kit) and prepare a dilution with
a concentration of 1 pg/ul. Divide this carrier RNA solution in a
number of aliquots adequate to your needs and store them at -20°C.
Avoid repeated thawing (> 2 x) of a carrier RNA aliquot.

-
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b) Use 1 ug carrier RNA per 100 pl lysis buffer. For instance, if the
extraction protocol suggests 200 pl lysis buffer, please add 2 pl carrier
RNA (1 pg/pl) directly into the lysis buffer. Before beginning of each
extraction, a mixture of lysis buffer and carrier RNA (and Internal
Control, where applicable, see 8.2 Internal Control) should be

prepared freshly according to the following pipetting scheme:

Number of samples 1 12

Lysis buffer e.g. 200 pl e.g. 2,400 pl
Carrier RNA (1 pg/ul) 2l 24 4l
Total Volume 202 pl 2,424 ul
Volume per extraction 200 pl each 200 pl

c) Please use the freshly prepared mixture of lysis buffer and carrier
RNA instantly for extraction. Storage of the mixture is not possible.

* The use of carrier RNA is critical for the extraction efficiency and,
consequently, for DNA/RNA yield. To increase the stability of the carrier
RNA provided with the QlAamp UltraSens Virus Kit, we recommend the
following procedure deviant from the user manual of the extraction kit:

a. Resuspend the lyophilised carrier RNA prior to first use of the

extraction kit in 310 pl of the elution buffer provided with the kit (final
concentration 1 pg/ul, do not use lysis buffer). Portion this carrier
RNA solution into a number of aliquots adequate to your needs and
store them at -20°C. Avoid repeated thawing (> 2 x) of a carrier RNA
aliquot.

b. Before the beginning of each extraction, a mixture of lysis buffer and
carrier RNA (and Internal Control, where applicable, see 8.2 Internal
Control) should be prepared freshly according to the following
pipetting scheme:

Number of samples 1 12

Lysis buffer AC 800 ul 9,600 pl
Carrier RNA (1 pg/ul) 5.6 ul 67.2 ul
Total Volume 805.6 pl 9,667.2 pl
Volume per extraction 800 pl each 800 pl
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c. Please use the freshly prepared mixture of lysis buffer and carrier
RNA instantly for extraction. Storage of the mixture is not possible.

* It is recommended to elute the DNA in 50 pl elution buffer to get the
highest sensitivity of the artus EBV TM PCR Kit.

* The QlAamp UltraSens Virus Kit allows a sample concentration. If you
use sample material other than serum or plasma, please add at least
50 % (v/v) of negative human plasma to the sample.

* Blood collection tubes coated with anticoagulants may inhibit the PCR.
However, these inhibitors will be eliminated by the use of the isolation kits
listed above. It is recommended to avoid the use of heparin blood.

* When using isolation protocols with ethanol-containing washing buffers,
please carry out an additional centrifugation step (three minutes,
13,000 rpm) before the elution to remove any remaining ethanol. This
prevents possible inhibition of PCR.

e The artus EBV TM PCR Kit should not be used with phenol-based

isolation methods.

Important note for the use of the EZ1 DSP Virus Kit:

» The use of carrier RNA is critical for the extraction efficiency and,
consequently, for DNA/RNA vyield. Please add the appropriate amount of
carrier RNA to each extraction following the instructions in the EZ1 DSP
Virus Kit Handbook.

Important: The Internal Control of the artus EBV TM PCR Kit can be used

directly in the isolation procedure (see 8.2 Internal Control).

8.2 Internal Control

An Internal Control (EBV RG/TM IC) is supplied. This allows the user both to
control the DNA isolation procedure and to check for possible
PCR inhibition (see Fig. 1). Using the EZ1 DSP Virus Kit for extraction, the
Internal Control has to be added following the instructions in the EZ1 DSP
Virus Kit Handbook. Using the QlAamp UltraSens Virus Kit, the QlAamp
DNA Blood Mini Kit, or the QlIAamp DNA Mini Kit, add the Internal Control

artus EBV TM PCR Kit 03/2007 11



to the isolation at a ratio of 0.1 pl per 1 pl elution volume. For example, using
the QIAamp UltraSens Virus Kit the DNA is eluted in 50 ul AVE buffer. Hence,
5 ul of the Internal Control should be added initially. The quantity of Internal
Control used depends only on the elution volume. The Internal Control and
carrier RNA (see 8.1 DNA Isolation) should be added only

* to the mixture of lysis buffer and sample material or
e directly to the lysis buffer.

The Internal Control must not be added to the sample material directly. If
added to the lysis buffer please note that the mixture of Internal Control and
lysis buffer/carrier RNA has to be prepared freshly and used instantly (storage
of the mixture at room temperature or in the fridge for only a few hours may
lead to Internal Control failure and a reduced extraction efficiency). Please do
not add the Internal Control and the carrier RNA to the sample material

directly.

The Internal Control can optionally be used exclusively to check for
possible PCR inhibition (see Fig. 2). For this application, add 2 ul of the
Internal Control per reaction directly to 30 ul EBV RG/TM Master. For each
PCR reaction use 30 pl of the Master Mix produced as described above™ and
add 20 pl of the purified sample. If you are preparing a PCR run for several
samples please increase the volume of the EBV RG/TM Master and the
Internal Control according to the number of samples (see 8.4 Preparing the
PCR).

8.3 AQuantitation

The enclosed Quantitation Standards (EBV LC/RG/TM QS 1 - 4) are treated
as previously purified samples and the same volume is used (20 ul). To
generate a standard curve on an ABI PRISM® Sequence Detection System, all
four Quantitation Standards should be used and defined as standards with

specification of the corresponding concentrations (see 8.5 Programming the

" The volume increase caused by adding the Internal Control is neglected when preparing
the PCR assay. The sensitivity of the detection system is not impaired.
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ABI PRISMP SDS). The import of standard curves from previous runs is not
possible with the ABI PRISM® 7000, 7700 and 7900HT SDS software.

Attention: The Quantitation Standards are defined as copies/pl. The following
equation has to be applied to convert the values determined using the

standard curve into copies/ml of sample material:

Result (copies/ul) x Elution Volume (pl)

Result (copies/ml) =

Sample Volume (ml)

Please note that as a matter of principle the initial sample volume should be
entered in the equation above. This has to be considered when the sample
volume has been changed prior to the nucleic acid extraction (e.g. narrowing
the volume by centrifugation or increase of volume by replenishment to the

volume required for the isolation).

Important: A guideline for the quantitative analysis of artus systems on the
ABI PRISM® 7000 SDS is provided at
www.qgiagen.com/Products/ByLabFocus/MDX (Technical Note for
quantitation on the ABI PRISM 7000 SDS).
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8.4 Preparing the PCR

Prepare the number of required reaction tubes or a 96-well reaction plate for
the scheduled reactions. Recommended materials are listed in the following
table:

Catalogue

Retaining | Compression

Article Description Number Manufacturer Rack’ Pad
96-well
optical | 96-Well Optical Applied i
reaction | Reaction Plate 4 306 737 Biosystems no
plate
Optical Optical .
‘ . Applied )
adhesive Adhesive 4 311 971 Biosystems yes
covers Covers
Optical ABI PRISM® Applied
reaction | Optical Tubes, | 4 316 567 Biosvstems yes -
tubes 8 Tubes/Strip y
Optical . ® .
: MicroAmp Applied )
reaction Optical Tubes N8010933 Biosystems yes
tubes
Optical ABI PRISM® Aoplied
caps Optical Caps, | 4323 032 Bi ospst ems - no
(flat) 8 Caps/Strip y

Attention: The use of reaction tubes for optical analyses with domed caps is
only permitted with the ABI PRISM® 7700 SDS and requires an adjustment of
the exposure time (see 8.5.2 Programming the ABI PRISM® 7700 SDS,
8.5.2.5 Important Additional Settings).

When preparing the PCR reaction, please make sure that at least one
Quantitation Standard per PCR run as well as one negative control (Water,
PCR grade) are performed in parallel. To generate a standard curve, use all
supplied Quantitation Standards (EBV LC/RG/TM QS 1 - 4) for each PCR run.
Before each use, all reagents need to be thawed completely, mixed (by
repeated up and down pipetting or by quick vortexing) and centrifuged briefly.

" If the two-part retaining rack is used, it is necessary to open the reaction tubes when
inserting them into and removing them from the rack. In order to avoid contamination
due to this procedure, please use the lower part of the retaining rack only.
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If you want to use the Internal Control to monitor the DNA isolation
procedure and to check for possible PCR inhibition, it has already been
added to the isolation (see 8.2 Internal Control). In this case, please use the

following pipetting scheme (for a schematic overview see Fig. 1):

Number of samples 1 12 ‘
1. Preparation of EBV RG/TM Master 30 pl 360 pl
Master Mix EBV RG/TM IC 0l oul
Total Volume 30 pl 360 pl
2. Preparation of |, Master Mix 30 pl 30 ul each
PCR assay Sample 20 pl 20 pl each
Total Volume 50 pl 50 pl each

If you want to use the Internal Control exclusively to check for
PCR inhibition, it must be added directly to the EBV RG/TM Master. In this
case, please use the following pipetting scheme (for a schematic overview see
Fig. 2):

Number of samples 1 12 ‘
1. Preparation of EBV RG/TM Master 30 l 360 pl
Master Mix | EBYAGTMIC 2 24yl
Total Volume 32 i 384 pl
2. Preparation of Master Mix 30 pl 30 ul each
PCR assay Sample 20 pl 20 pl each
Total Volume 50 pl 50 pl each

Pipette 30 ul of the Master Mix into each required reaction tube or well of the
96-well reaction plate. Subsequently add 20 ul of the eluate from the
DNA isolation. Mix the solution well by repeated up and down pipetting. Close
the reaction tubes with the corresponding caps or, alternatively, when using a
96-well reaction plate, with optical adhesive covers (Optical Adhesive Covers).
Centrifuge the reaction tubes (in a storage rack for PCR tubes) or the 96-well
reaction plate in a centrifuge with a microtitre plate rotor for 30 seconds at
1,780 x g (4,000 rpm) in order to collect the prepared reaction volume in the

" The volume increase caused by adding the Internal Control is neglected when preparing
the PCR assay. The sensitivity of the detection system is not impaired.

|
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bottom of the tube or well. If such a centrifuge is not at your disposal, please
make sure that both the Master Mix and the sample volume are pipetted to the
bottom of the tubes or wells. Store the prepared reactions at +4°C until the
ABI PRISM® SDS Instrument is programmed (see 8.5 Programming the
ABI PRISMP SDS) and subsequently transfer them into the instrument.

Attention:

* When using optical reaction tubes in combination with optical caps,
always insert a retaining rack (96-Well Tray/Retainer Set) into the
instrument (ABI PRISM® 7000, 7700 and 7900HT SDS). If the two-part
retaining rack is used, it is necessary to open the reaction tubes when
inserting them into and removing them from the rack. In order to avoid
contamination due to this procedure, please use the lower part of the
retaining rack only.

* Using 96-well optical reaction plates in combination with optical adhesive
covers requires covering by a compression pad (Optical Cover
Compression Pads).
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Addition of the Internal Control to the Purification Procedure

Fig. 1:  Schematic workflow for the control of both the purification
procedure and PCR inhibition.

Please make sure that the solutions are thawed completely,
mixed well and centrifuged briefly.
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Addition of the Internal Control into the artus Master

Fig. 2:  Schematic workflow for the control of PCR inhibition.

Please make sure that the solutions are thawed completely,
mixed well and centrifuged briefly.
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8.5 Programming the ABI PRISM® SDS

The software of the ABI PRISM® 7000, 7700 and 7900HT Sequence Detection
Systems (SDS) requires some additional information before starting the PCR
run. The programming procedures of the instruments, however, differ
considerably from each other, which is why they are treated in separate

chapters as follows.

8.5.1 Programming the ABI PRISM® 7000 SDS

For the detection of EBV DNA, create a profile on your ABI PRISM® 7000 SDS
according to the following six steps (8.5.1.1 - 8.5.1.6). All specifications refer
to the ABI PRISM® 7000 SDS software version 1.0.1. For programming details
of the ABI PRISM® 7000 SDS, please refer to the ABI PRISM® 7000 SDS
User Guide. For a better overview, the software settings are framed in bold
black.

8.5.1.1 Pre-Settings for Creating a New PCR Run
Select the item New from the File menu on the ABI PRISM® 7000 SDS and

programme the following initial settings for the new document (see Fig. 3). A
backup template (SDS Template [*.sdf]) is available from the Template list or
by selection using the Browse function (see 8.5.1.5 Saving the PCR Run).

Confirm your pre-settings (OK).

New Document

Assay ! |Absolute Quantitation

Container : I95-Wel| Clear 1

Template : IBIank Document

Browse ... |
2
concel_|

Fig. 3: Pre-settings for creating a new PCR run (New Document).
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8.5.1.2 Creating/Selecting the Detectors

With the help of the submenu Detector Manager from the Tools menu, assign
the corresponding detector dyes to the file. For the detection of EBV DNA as
well as the Internal Control by means of the artus EBV TM PCR Kit, the
reporters/quenchers listed in the following table are to be defined:

Detection Reporter Quencher
EBV DNA FAM none
Internal Control (EBV RG/TM IC) VIC none

To create these detectors, select the option File (bottom left of the Detector

Manager) and subsequently the option New.

x] x
. Meme: [osEEV Naine: [arus EEBVIC
Description: |anus EBV TM PCR Kit Description; [amsavmpcm:n 1
1— Reporter Dye: [FAM -] Reporter Dye: [VIC |
Quencher Dye: [(rone) | QuencherDye: [(none) |
Color: . Color: .
Notes: Notes:
2 | 2
Create Ancther 0 Cancsl Greate Another | I_!K_I Cancel |
Fig. 4: Creating the EBV specific detector Fig. 5: Creating the IC specific detector
(Detector Manager). (Detector Manager).

For the detection of EBV DNA define the reporter/quencher combination
FAM/none in the new window. For the detection of the Internal Control, select
the combination VIC/none (as shown in Fig. 4 and Fig. 5). By confirming the
input data (OK), return to the Detector Manager. Mark the newly created
detectors and transfer each selection to the Well Inspector by clicking on the

option Add to Plate Document (see Fig. 6). Close the window (Done).

|
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Detector Manager [ &
— Detector List
Fingt j j
JDetector Name| Description | Reporter | Quencher [Color| Notes | A 1
artus EBY artus EBY TM PCR Kit FAM (none) | ]
artus EBYV IC  artus EBY TM PCR Kit VIC (none) -
Fie ~ | | AddToPiete Document | 2
|
e 13

Fig. 6: Selecting the detectors (Detector Manager).

8.5.1.3 Assigning the Necessary Information to the Plate Positions

Open Well Inspector from the View menu to find the detectors selected under
8.5.1.2 (see Fig. 7).

et mpector ﬂ

Well(s):

Sample Name: IDS1

Detector Reporter Quencher
W lartus EBY FAM (none) Standard b
v lartus EBY IC

| -
K1 ! o
I~ Omitwell :
assive
sdd Detectclr_l Remove | BOX = T 2
—1

Fig. 7: Assigning the necessary information to the plate positions (Well Inspector).

Mark the plate positions reserved for the detection of EBV DNA. Assign the
selected detectors to these positions by activating the Use option of both
detectors, upon which a tick will appear. For the denomination of each single
reaction, select the corresponding position on the plate and enter the name
(Sample Name). Please note that preparations with an identical Sample Name
and an identical detector assignment will be identified as replicates by the
software and will be averaged with respect to the quantified pathogen load.

Then select the corresponding function ( Task) for each sample type according
to the following table:
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Function Concentration

Sample Type (Task) (Quantity) Reporter Quencher
Sample Unknown - FAM none
Non-template NTC : FAM none
control

Standard Standard | see 1. Contents FAM none

To generate a standard curve, use all supplied Quantitation Standards
(EBVLC/RG/TM QS 1-4) per PCR run and enter the corresponding
concentrations (see 1. Contents) for each standard (Quantity). Please note
that for a PCR run with the artus EBV TM PCR Kit, ROX has to be set as a
passive reference (Passive Reference). The equal distribution of the ROX dye
in all PCR preparations of a lot by mixing of the EBV RG/TM Master
guarantees the recognition and calculation of tube-to-tube variations
(fluorescence differences between several PCR preparations) by means of the
Sequence Detection Software (normalization).

8.5.1.4 Creating the Temperature Profile

To create a temperature profile, switch from the Setup level to the Instrument
level in the software. Enter the temperature profile specific for the detection of
EBV DNA according to Fig. 8. In order to remove the 50°C step stored in the
pre-settings, mark it with the left mouse button simultaneously holding the shift
key, and subsequently delete it by using the backspace key. Make sure that
the reaction volume is set to 50 ul. The option 9600 Emulation should be
activated, the pre-settings of the Auto Increment should remain unchanged
(Auto Increment. 0.0°C, 0.0 Seconds).
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Thermal Cycler Protocol

Thermal Profile I Auto Increment ]

Stage 1 Stage 2
Reps ] RepsfE_]
50 Ppso |
0:00 P15 | 1
550 |
| Add Hol | Add Sgep| Sample Volume [5g  (ul) 2
I” Dissociation Protocol 1lLE
v E mulation | 3

Fig. 8: Creating the temperature profile.

8.5.1.5 Saving the PCR Run

Save the settings (Setup) as a template in order to make use of them again
later in a modified or unchanged form. By saving the settings as a SDS
Template (*.sdt) in the Template Directory (Local Disk [C:]\Program Files\
ABI PRISM 7000\Templates, created by Applied Biosystems), this file may be
selected directly in the New Document window from the Template drop-down
list. Copies stored in other folders have to be opened via Browse. Before
starting the PCR run, save it again as a SDS Document (*.sds), in order to
guarantee the saving of the data that will be collected during the course of the
PCR.

8.5.1.6 Starting the PCR Run

Start the PCR run by selecting the option Start from the menu item Instrument

or the field Start on the Instrument level.
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8.5.2 Programming the ABI PRISM® 7700 SDS
For the detection of EBV DNA, create a profile on your ABI PRISM® 7700 SDS

according to the following seven steps (8.5.2.1 - 8.5.2.7). All specifications
refer to the ABI PRISM® 7700 SDS software version 1.9.1. For programming
details of the ABI PRISM® 7700 SDS, please refer to the ABI PRISM® 7700
SDS User's Manual. For a better overview, the software settings are framed in
bold black.

8.5.2.1 Pre-settings for Creating a New PCR Run

Select the item New Plate from the File menu on the ABI PRISM® 7700 SDS
and programme the following initial settings for the new document (see Fig. 9).
Confirm the pre-settings (OK).

New Plate
Plate Type: [ Single Reporter i]
—Data Acquisition 1

Plate Format: | Standard Plate 3|

Run: [ Real Time Bl

T | o o

Fig. 9: Pre-settings for creating a new PCR run (New Plate).

8.5.2.2 Selecting the Fluorescence Dyes and Assigning the Sample
Type

With the help of the Sample Type Setup (Setup level: Sample Type/Sample

Type Setup) assign the corresponding detector dyes and the corresponding

sample type to the file. For the detection of EBV DNA as well as the Internal

Control by means of the artus EBV TM PCR Kit, the reporters/quenchers

listed in the following table are to be defined:

24 artus EBV TM PCR Kit 03/2007



Detection Reporter Quencher
EBV DNA FAM none
Internal Control (EBV RG/TM IC) VIC none

For the analysis of EBV DNA by means of the artus EBV TM PCR Kit, select
the reporter dye FAM as given in the table. This applies to standards (STND)
and samples (UNKN) as well as to non-template controls (UNKN). For the
analysis of the Internal Control (IPC+), define VIC as reporter. As quencher
set none. The assignment of the dyes and sample types in the window
Sample Type Setup is shown in Fig. 10.

Sample Type Setup

Acronym HName Color Reporter
[Pc+ ] [internal Positive [ (vie 2] B

o ] [rondrd [= '
o ] oo [

4

4

»

[uikn ] [Ho Template Control || | [Fam = :
Reference
ROX -2
—
Eme (Ccancel J [Cox_J)H-3

Fig. 10: Selecting the fluorescence dyes and assigning the sample type
(Sample Type Setup).

Please assign the sample type to a corresponding function (Acronym)
according to the following table:

Function Concentration

Sample Type (Acronym) (Quantity) Reporter Quencher
Sample UNKN - FAM none
Non-template

control UNKN - FAM none
Standard STND see 1. Contents FAM none
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8.5.2.3 Assigning the Necessary Information to the Plate Positions

For the assignment of the detectors and sample types to the individual plate
positions, select the corresponding fields. Then open the dialogue window
Dye Layer on the Setup level and assign the corresponding reporter. Upon
activation of the pop-up menu Sample Type, you will find the sample types
assigned to the reporter in the Sample Type Setup in the appearing list
(see Fig. 11). Select the adequate sample type (see Table under 8.5.2.2) and
assign the remaining plate positions by means of the Dye Layers and the
Sample Type menu. A name may be assigned to each sample in the field
Sample Name. Fields defined as Replicates (entering of the name of the
reference sample into the Replicate column) are averaged by the software

with respect to the quantified pathogen load and the standard deviation will be

calculated.
ample Type: |® STND - Standard ample Type: | STND - Standard 3
ie Hame: UNKN - Unknown T
1 ample Hame: | )y y - No Template Control ample Name: |05 1
Replicate:| Sample Type Setup... Replicate: |
Quantity: | Not In Use Quantity: |1 pe+04
2 Show Analysis f Dye Laver: | Fam Show Analysis _[[05% Layer 1 Far <]
— = 2
2 3 4 5 2 3 4 5
B B

Fig. 11/12: Assigning the necessary information to the plate positions.

To generate a standard curve, use all supplied Quantitation Standards
(EBVLC/RG/TM QS 1-4) per PCR run and enter the corresponding
concentrations (see 1. Contents) for each standard into the field Quantity
(see Fig. 12). This is only possible, however, if the positions reserved for
standards were defined as such before by means of the Sample Type menu.
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8.5.2.4 Creating the Temperature Profile

To create a temperature profile, switch to the Thermal Cycler Conditions menu
on the Setup level. Enter the temperature profile specific for the detection of
EBV DNA according to Fig. 13. Make sure that the reaction volume is set to
50 pl. The pre-settings of the Ramp times and of the Auto Increment remain
unchanged (Ramp Time: 0:00, Auto Increment. 0.0°C, 0.0 Seconds).

Thermal Cycler Conditions
Stagel Stage2
Repeat

1

[4]»]

5 LA Auto Increment | Sample Yolume Show Data Collection I
fetdd Ml |  oriEe | 50 w 2

Wrkamp te . | | o4 Seconds .

e [ ok )3

Fig. 13: Creating the temperature profile.

In addition, the Thermal Cycler Conditions menu contains the option Show
Data Collection. By selecting this option the window depicted in Fig. 14 is
opened. Each ramp and each plateau temperature shows a Data Collection
Icon, which illustrates the data being collected at this stage of the run.
Remove all symbols except the one for the Annealing-Extension step
(Stage2/Step2) in order to exclude unnecessary fluorescence measurements.
The total run time and the data quantity will thus be kept at a minimum.
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Thermal Cycler Conditions
Stagel Stage?2
Repeat
Kl

AR Auto Increment  Sample Yolume Show Time And Temp |

A Hal [ o | 50 u

%t famp Yime . | | 02 Seconds
R
—2

Fig. 14: Data collection.

8.5.2.5 Important Additional Settings

For the setting of the exposure time (excitation of the fluorescence dyes) as
well as for the selection of the Pure Spectra/Background files, switch from the
Setup level to the Analysis level. Select the activated sub-item Advanced
Options to be found in the Instrument menu under Diagnostics. Adjust the
settings according to Fig. 15. By inactivating the optional function Spectra
Components (Analysis) the actual calibration files stored in the file Spectra
Components at the moment of data generation are automatically used when
re-evaluating already analysed runs. For an analysis of previous runs by using
newly entered Spectra Components, activate these two fields. Please note
that for a PCR run with the artus EBV TM PCR Kit, ROX has to be set as a
passive reference (Reference). The equal distribution of the ROX dye in all
PCR preparations of a lot by mixing of the EBV RG/TM Master guarantees the
recognition and calculation of tube-to-tube variations (fluorescence differences
between several PCR preparations) by means of the Sequence Detection

Software (normalization).
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Attention: When using 96-well reaction plates for optical measurements in
combination with optical adhesive covers or optical reaction tubes with flat
caps, the exposure time is ten milliseconds. If you use optical reaction tubes

with domed caps, you have to adjust this exposure time to 25 milliseconds.

Advanced Options

isplay mse in Multicomponent Yiew

isplay best fit in Raw Spectra View

——Analysis: Spectra Components

Imtse background in "Spectra Components" folder

se pure spectra in "Spectra Components” folder

——Miscellaneous

Set 7700 Exposure Time for Plates: 4

Ceaneet) (32 -6

Fig. 15: Important additional settings (Advanced Options).

8.5.2.6 Saving the PCR Run

Save the settings (Setup) as a template in order to make use of them again
later in a modified or unchanged form. For this purpose store the file in the
Stationary File Format. Before starting a newly programmed PCR run, please
save it again in the Normal File Format in order to guarantee the saving of

data that will be collected during the course of the PCR.
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8.5.2.7 Starting the PCR Run

Start the PCR run by selecting the option Run from the menu item Instrument

or the field Run on the Analysis level.
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8.5.3 Programming the ABI PRISM® 7900HT SDS

For the detection of EBV DNA, create a profile on your ABI PRISM® 7900HT
SDS according to the following six steps (8.5.3.1 - 8.5.3.6). All specifications
refer to the ABI PRISM® 7900HT SDS software version 2.1. For programming
details of the ABI PRISM® 7900HT SDS, please refer to the ABI PRISM®
7900HT SDS User Guide. For a better overview, the software settings are

framed in bold black.

8.5.3.1 Pre-Settings for Creating a New PCR Run

Select the item New from the File menu on the ABI PRISM® 7900HT SDS and
programme the following initial settings for the new document (see Fig. 16). A
backup template (ABI PRISM® SDS Template Document [*.sdf]) is available
from the Template list or by selection using the Browse function (see
8.5.3.5 Saving the PCR Run). Confirm the pre-settings (OK).

Attention: The artus EBV TM PCR Kit may not be used in combination with
the 384 plate format of the ABI PRISM® 7900HT SDS.

T
Assay: ]Absolute Quantification (Standard Curve) L‘
Corntainer: IQB Wells Clear Plate Ll =1
Template: |Blank Template ~|

Browse... |

Barcode: |

Fig. 16: Pre-settings for creating a new PCR run (New Document).
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8.5.3.2 Creating/Selecting the Detectors

With the help of the submenu Detector Manager from the Tools menu
(alternatively: Setup level/Add Detector select function), assign the
corresponding detector dyes to the file. For the detection of EBV DNA as well
as the Internal Control by means of the artus EBV TM PCR Kit, the

reporters/quenchers listed in the following table are to be defined:

Detection Reporter Quencher
EBV DNA FAM Non Fluorescent
Internal Control (EBV RG/TM IC) VIC Non Fluorescent

To create these detectors, select the option New (bottom left of the Detector

Manager).
-
Add Detector E Add Detector E
e -] T
Narme: | artus EBY Narme: | artus EBY IC
Description: | arus EBY TM PCR Kit Description: |artus EBY T PCR Kit
1 Reporter: [FAM "l Reporter: I‘JIC =
Quencher: INnn Fluorescent vl Quencher: |N|Jn Fluarescent 'l
Color: . Color: I
hotes: [

Notes: |

—-2

2 &I@ ﬂl

Fig. 17: Creating the EBV specific Fig. 18: Creating the /C specific detector
detector (Detector Manager). (Detector Manager).

For the detection of EBV DNA define the reporter/quencher combination
FAM/Non Fluorescent in the new window. For the detection of the Internal
Control, select the combination VIC/Non Fluorescent (as shown in Fig. 17
and Fig. 18). By confirming the input data (OK), return to the Detector
Manager. Mark the newly created detectors and transfer each selection to the
Setup level by clicking on the option Copy to Plate Document (see Fig. 19).
Close the window (Done).
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Detector Manager

Find: | ;l j
| Nane | Repoter | Quencher | Color| Moiification Date
rtus EBY FAM Non Fluorescent — - 1
rtus EBY IC WIC Mon Fluorescent | ]
Newy... | Open | Save As... | Import... I Export... | I Copy To Plate Document e 2

Fig. 19: Selecting the detectors (Detector Manager).

8.5.3.3 Assigning the Necessary Information to the Plate Positions

After having closed the Detector Manager (Done) the detectors selected under
8.5.3.2 are found on the Setup level listed in a table (see Fig. 20).

Setup | instrumert |

Well(s): A1 [
Sample Name: |01551

Use Detector Reporter | Task | Quantty | Color |

X artus EBY FaM Standard = 14| I

r>z artus EBV IC VIC Unknown 0| . e 4

NTC
Add Detector ... | Clear, | Copyite Mansger

Passive Reference: |R0}( ¥ |I 2
[ Omit Well(s)

Fig. 20: Assigning the necessary information to the plate positions.

Mark the plate positions reserved for the detection of EBV DNA. Assign the
selected detectors to these positions by activating the Use option of both
detectors, upon which a cross will appear. For the denomination of each
single reaction, select the corresponding position on the plate and enter the
name (Sample Name). Please note that preparations with an identical Sample
Name and an identical detector assignment will be identified as replicates by
the software and will be averaged with respect to the quantified pathogen
load. Then select the corresponding function (Task) for each sample type
according to the following table:
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Function Concentration

Sample Type (Task) (Quantity) Reporter Quencher
Sample Unknown - FAM Non Fluorescent
Non-template NTC - FAM Non Fluorescent
control

Standard Standard | see 1. Contents FAM Non Fluorescent

To generate a standard curve, use all supplied Quantitation Standards
(EBVLC/RG/TM QS 1-4 per PCR run and enter the corresponding
concentrations (see 1. Contents) for each standard (Quantity). Please note
that for a PCR run with the artus EBV TM PCR Kit, ROX has to be set as a
passive reference (Passive Reference). The equal distribution of the ROX dye
in all PCR preparations of a lot by mixing of the EBV RG/TM Master
guarantees the recognition and calculation of tube-to-tube variations
(fluorescence differences between several PCR preparations) by means of the

Sequence Detection Software (normalization).

8.5.3.4 Creating the Temperature Profile

To create a temperature profile, switch from the Setup level to the Instrument
level in the software. Enter the valid temperature profile for the detection of
EBV DNA according to Fig. 21. Make sure that the reaction volume is set to
50 ul. The option 9600 Emulation should be activated, the pre-settings of the
Ramp time and the Aufo Increment should remain unchanged
(Ramp Time: 0:00, Auto Increment: 0.0°C, 0.0 Seconds).
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Setup  Instrument |

~Thermal Cycler Protocol
Thermal Profile I Auto Incrementl Ramp Rate] Data Collectionl
Stage 1 Stage 2
Repeats [E
|95.D IQS.D
adacyce | sddrod | sdastep | oektesten | SatmplE sl (“L):I._ 2
50

Add Dissociation Stage

v 9600 Ermulation 3

Fig. 21: Creating the temperature profile.

In addition, the Instrument level contains the option Data Collection. By
selecting this option the window depicted in Fig. 22 is opened. Each ramp and
each plateau temperature shows a Data Collection Icon, which illustrates the
data being collected at this stage of the run. Remove all symbols except the
one for the Annealing-Extension step (Stage2/Step2) by clicking on them in
order to exclude unnecessary fluorescence measurements. The total run time

and the data quantity will thus be kept at a minimum.
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Setup Instrument |

Ji
~Thermal Cycler Protocol
Thermal Profile | Auto Increment | Remp Rete Deta Collection |
Stage 1 Stage 2 al
Repeats ]E-
95.0 950
=1
55.0
D g
=l
— . —
£l Cycle | SddHol l £dd|Gten | Delete Step I Sample Yolume (uL):
a0
Ldd DissaciEtion Stage |
[¥ 9600 Emulation

Fig. 22: Data collection.

8.5.3.5 Saving the PCR Run

Save the settings (Setup) as a template in order to make use of them again
later in a modified or unchanged form. By saving the settings as an
ABI PRISM® SDS Template Document (*.sdf) in the Template Directory
([D:]\Program Files\Applied Biosystems\SDS 2.1\Templates, created by
Applied Biosystems), this file may be selected directly in the New Document
window from the Template list. Copies stored in other folders have to be
opened via Browse. Before starting the PCR run, save it again as an
ABI PRISM® SDS Document (*.sds) in order to guarantee the saving of the

data that will be collected during the course of the PCR.

8.5.3.6 Starting the PCR Run

Start the PCR run by selecting the option Start from the menu item Instrument.
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9. Data Analysis

A valid calibration of the dyes (Pure Spectra Component File) and the
background (Background Component File) is necessary when putting the
instruments into operation. These calibration files are required for the exact

calculation of the results as follows:

All interfering signals generated by the instruments which influence the
measurement are eliminated by the Sequence Detection Software of the
ABI PRISM® Sequence Detection Systems by means of the Background
Component File.

Furthermore, interferences appear during multicolour analyses between the
emission spectra of the single fluorescence dyes. The software of the
ABI PRISM® SDS compensates these interferences by calculations using the
spectrum data of the individual dyes stored in the Pure Spectra Component
File. The software uses the same file for the assignment of the fluorescence
data comprising the entire measurable spectrum collected in the course of the
PCR to the programmed detectors. The fluorescence data of the individual
dyes are subsequently divided by the value obtained for the signal of the
passive reference (ROX) in order to account for tube-to-tube variations
(fluorescence differences between several PCR preparations). The thus

normalized signals may then be evaluated by means of the Amplification Plot.

The calibration files used for the evaluation of a PCR run are automatically
stored with the saving of the run. If no calibration files are installed, please
create these files according to the instructions given in the ABI PRISM® SDS
User Guide/Manual.

If more than one artus TM PCR system is integrated in your PCR run (note
temperature profile), these assays should be analysed separately. Samples
with an identical Sample Name and an identical detector assignment will
automatically be identified as replicates by the ABI PRISM® 7000 and 7900HT
SDS Software and will be averaged with respect to the quantified pathogen

load.
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The following results are possible:

1. A FAM fluorescence signal is detected.
The result of the analysis is positive: The sample contains EBV DNA.

In this case, the detection of a VIC fluorescence signal (Internal Control) is
dispensable, since high initial concentrations of EBV DNA (positive FAM
fluorescence signal) can lead to a reduced or absent fluorescence signal of the
Internal Control (competition).

2. No FAM fluorescence signal is detected. At the same time, a VIC
fluorescence signal from the Internal Control appears.

In the sample no EBV DNA is detectable. It can be considered

negative.

In the case of a negative EBV PCR the detected signal of the Internal Control rules
out the possibility of PCR inhibition.

3. Neither a FAM fluorescence signal nor a VIC fluorescence signal is
detected.
No result can be concluded.

Information regarding error sources and their solution can be found in
10. Troubleshooting.

Examples of positive and negative PCR reactions are given in Fig. 23/24
(ABI PRISMP 7000 SDS), 25/26 (ABIPRISM® 7700 SDS) and 27/28
(ABI PRISMP 7900HT SDS).
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Fig. 23: Detection of the Quantitation Standards (EBV LC/RG/TM
QS 1-4) by measurement of the FAM fluorescence signal
(ABI PRISMP 7000 SDS). NTC: non-template control
(negative control).
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Fig. 24: Detection of the Internal Control (IC) by measurement of the
VIC fluorescence signal (ABIPRISM® 7000 SDS) with
simultaneous amplification of the Quantitation Standards
(EBVLC/RG/TM QS 1-4). NTC: non-template control
(negative control).
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Fig. 25: Detection of the Quantitation Standards (EBV LC/RG/TM
QS 1-4) by measurement of the FAM fluorescence signal
(ABI PRISMP 7700 SDS). NTC: non-template control
(negative control).

Fig. 26: Detection of the Internal Control (IC) by measurement of the
VIC fluorescence signal (ABIPRISM® 7700 SDS) with
simultaneous amplification of the Quantitation Standards
(EBVLC/RG/TM QS 1-4). NTC: non-template control
(negative control).
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Fig. 27: Detection of the Quantitation Standards (EBV LC/RG/TM
QS 1-4) by measurement of the FAM fluorescence signal
(ABI PRISMP  7900HT SDS). NTC: non-template control
(negative control).
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Fig. 28: Detection of the Internal Control (IC) by measurement of the
VIC fluorescence signal (ABI PRIS 7900HT SDS) with
simultaneous amplification of the Quantitation Standards
(EBVLC/RG/TM QS 1-4). NTC: non-template control
(negative control).
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10. Troubleshooting

No FAM fluorescence signal with positive controls (EBV LC/RG/TM

QS 1-4):

* The selected detection dye for PCR data analysis does not comply with
the protocol.

- For data analysis select the detection dye FAM for the analytical
EBV PCR and the detection dye VIC for the Internal Control PCR.

* The settings used for the data analysis under Options (Extension Phase
Data Extraction) do not correspond to the settings of the Data Collection
(for ABI PRISM® 7700 SDS see 8.5.2.4 Creating the Temperature
Profile, for ABI PRISM® 7900HT SDS see 8.5.3.4 Creating the
Temperature Profile).
= Analyse the PCR run with corrected settings and repeat the data

analysis (Analysis).

* Incorrect programming of the temperature profile of the ABIPRISM®
Sequence Detection System.
> Compare the temperature profile with the protocol (see

8.5 Programming the ABI PRISM® SDS).

* Incorrect configuration of the PCR reaction.

= Check your work steps by means of the pipetting scheme (see
8.4 Preparing the PCR) and repeat the PCR, if necessary.

* The storage conditions for one or more kit components did not comply
with the instructions given in 2. Storage or the artus EBV TM PCR Kit had
expired.

- Please check the storage conditions and the expiration date (see the

kit label) of the reagents and use a new Kit, if necessary.

Weak or no signal of the Internal Control (VIC fluorescence signal) and
simultaneous absence of a FAM fluorescence signal for the specific
EBV PCR:
* The PCR conditions do not comply with the protocol.

- Check the PCR conditions (see above) and repeat the PCR with

corrected settings, if necessary.
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* The PCR was inhibited.

- Make sure that you use a recommended isolation method
(see 8.1 DNA Isolation) and stick closely to the manufacturer’s
instructions.

- Make sure that during the DNA isolation the recommended additional
centrifugation step has been carried out before the elution in order to
remove any residual ethanol (see 8.1 DNA Isolation).

* DNA was lost during extraction.
= If the Internal Control had been added to the extraction, an absent

signal of the Internal Control can indicate the loss of DNA during the
extraction. Make sure that you use a recommended isolation method
(see 8.1 DNA Isolation) and stick closely to the manufacturer’s
instructions.

* The storage conditions for one or more kit components did not comply
with the instructions given in 2. Storage or the artus EBV TM PCR Kit had
expired.

- Please check the storage conditions and the expiration date (see the
kit label) of the reagents and use a new Kit, if necessary.

A FAM fluorescence signal of the analytical PCR with the negative
controls:
* A contamination occurred during preparation of the PCR.
- Repeat the PCR with new reagents in replicates.
- |If possible, close the PCR tubes directly after addition of the sample to
be tested.
- Strictly pipette the positive controls at last.
- Make sure that work space and instruments are decontaminated at
regular intervals.
* A contamination occurred during extraction.
- Repeat the extraction and PCR of the sample to be tested using new
reagents.
- Make sure that work space and instruments are decontaminated at

regular intervals.
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If you have any further questions or if you encounter problems, please contact

our Technical Service.

11. Specifications

11.1 Analytical Sensitivity

In order to determine the analytical sensitivity of the artus EBV TM PCR Kit, a
standard dilution series has been set up from 50 to nominal 0.01 EBV copy
equivalents/ul and analysed by means of the ABI PRISM® 7000, 7700 and
7900HT  Sequence Detection Systems with the help of the
artus EBV TM PCR Kit. Testing for all instruments was carried out on three
different days on eight replicates. The results were determined by a
probit analysis. A graphical illustration of the probit analysis (ABI PRISM®
7000 SDS) is shown in Fig. 29.

Detection limit (p = 0.05)

ABI PRISMP 7000 SDS 5.3 copies/pl
ABI PRISMP 7700 SDS 1.4 copies/yl
ABI PRISMP 7900HT SDS 0.7 copies/yl

This means that there is a 95 % probability that 5.3 copies/ul (ABI PRISM®
7000 SDS), 1.4 copies/ul (ABIPRISM® 7700 SDS) and 0.7 copies/pl
(ABI PRISM® 7900HT SDS) will be detected.

" The standard is a cloned PCR product, the concentration of which has been determined
by absorption and fluorescence spectroscopy.
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Probit analysis: Epstein-Barr virus (ABI PRISM® 7000 SDS)

| 072322 253 copies/ul (95%)

Proportions

-35 -25 -1,5 -05 05 15 ] 35
log (dose)

Fig. 29: Analytical sensitivity of the arfus EBV TM PCR Kit
(ABI PRISM® 7000 SDS).

11.2 Specificity

The specificity of the artus EBV TM PCR Kit is first and foremost ensured by
the selection of the primers and probes, as well as the selection of stringent
reaction conditions. The primers and probes were checked for possible
homologies to all in gene banks published sequences by sequence
comparison analysis. The detectability of all relevant genotypes has thus been
ensured.

Moreover, the specificity was validated with six different EBV negative serum
samples. These did not generate any signals with the EBV specific primers
and probes, which are included in the EBV RG/TM Master.

To determine the specificity of the artus EBV TM PCR Kit the control group
listed in the following table (see Table 1) has been tested for cross-reactivity.
None of the tested pathogens has been reactive.
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Table 1: Testing the specificity of the kit with potentially cross-reactive pathogens.

Control group (IEEI\\III) Intern(?lll g)o L
Human herpesvirus 1 (Herpes simplex virus 1) - +
Human herpesvirus 2 (Herpes simplex virus 2) - +
Human herpesvirus 3 (Varicella-zoster virus) - +
Human herpesvirus 5 (Cytomegalovirus) - +
Human T cell leukemia virus 1 - +
Human T cell leukemia virus 2 - +

11.3 Reproducibility

Reproducibility data permit a regular performance assessment of the
artus EBV TM PCR Kit as well as an efficiency comparison with other
products. These data are obtained by the participation in established
proficiency programmes.

11.4 Diagnostic Evaluation

Currently, the artus EBV TM PCR Kit is undergoing a series of evaluation

studies.

12. Product Use Limitations

* The artus EBV TM PCR Kit is for research use only. Not for use in
diagnostic procedures.

* No claim or representation is intended for their use for a specific
clinical use (diagnostic, prognostic, or therapeutic).

e Strict compliance with the user manual is required for optimal PCR
results.

* Attention should be paid to expiration dates printed on the box and
labels of all components. Do not use expired components.
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13. Safety information

For safety information of the artus EBV TM PCR Kit, please consult the
appropriate material safety data sheet (MSDS). The MSDS are
available online in  convenient and compact PDF format at
www.dgiagen.com/support/msds.aspx.

14. Quality control

In accordance with QIAGEN’s ISO 9001 and ISO 13485-certified Quality
Management System, each lot of artus EBV TM PCR Kit has been tested
against predetermined specifications to ensure consistent product quality.

15. References

Mackay IM. Real-time PCR in the microbiology laboratory. Clin. Microbiol.
Infect. 2004; 10 (3): 190 - 212.
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16. Explanation of Symbols

2 Use by

LOT
Batch code
u Manufacturer
REF
Catalogue number
MAT Material number

Handbook

; <N> Contains sufficient for <N> tests

/H/ Temperature limitation

QS Quantitation Standard

| c Internal Control
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Austria = QIAGEN Vertriebs GmbH = Léwengasse 47/6 = 1030 Wien
Orders 0800/28-10-10 = Fax 0800/28-10-19 = Technical 0800/28-10-11

Canada = QIAGEN Inc. = 2800 Argentia Road = Unit 7 = Mississauga ® Ontario = L5N 8L2
Orders 800-572-9613 = Fax 800-713-5951 = Technical 800-DNA-PREP (800-362-7737)

France = QIAGEN S.A. = 3 avenue du Canada = LP 809 = 91974 COURTABOEUF CEDEX
Orders 01-60-920-920 = Fax 01-60-920-925 = Technical 01-60-920-930

Germany ®* QIAGEN GmbH = QIAGEN Strasse 1 = 40724 Hilden
Orders 02103-29-12000 = Fax 02103-29-22000 = Technical 02103-29-12400

Italy = QIAGEN S.p.A. = Via Grosio, 10/10 = 20151 Milano
Orders 02-33430-411 = Fax 02-33430-426 = Technical 800-787980

Japan = QIAGEN K.K. = Forefront Tower Il = 13-1, Kachidoki 3 Chome = Chuo-ku, Tokyo 104-0054
Telephone 03-5547-0811 = Fax 03-5547-0818 = Technical 03-5547-0811

Switzerland = QIAGEN AG = Garstligweg 8 ® 8634 Hombrechtikon
Orders 055-254-22-11 = Fax 055-254-22-13 = Technical 055-254-22-12

USA = QIAGEN Inc. = 27220 Turnberry Lane = Valencia = CA 91355
Orders 800-426-8157 = Fax 800-718-2056 = Technical 800-DNA-PREP (800-362-7737)
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